**Notices:** The information in this document is subject to change without notice. NO WARRANTY OF ANY KIND IS MADE WITH REGARD TO THIS MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. No liability is assumed for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material. This document contains proprietary information that is protected by copyright. All rights are reserved. No part of this document may be photocopied, reproduced, or translated into another language without prior written consent.

**Trademark Acknowledgments:** UNINET and UNINET IColor 250 are registered trademarks of Uninet Imaging, Inc. Windows is a registered trademark of Microsoft Corporation. All other trademarks are the property of their respective owners.

**Revision History**

Edition 1.2, Copyright 2020. All rights reserved.

**FCC Compliance Statement:** This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

**For Users in the United States:** This product is intended to be supplied by a UL listed Direct Plug-In Power Supply marked “Class 2” or a UL listed ITE Power Supply marked “LPS” with output rated 12VDC, 5A or higher. This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. In a domestic environment this product may cause radio interference, in which case the user may be required to take adequate measures. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re-orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Use of shielded cables is required to comply with the Class A limits of Part 15 of the FCC Rules. You are cautioned that any changes or modifications not expressly approved in this manual could void your authority to operate and/or obtain warranty service for this equipment.

**For Users in Canada:** This digital apparatus does not exceed the Class A limits for radio noise for digital apparatus set out on the Radio Interference Regulations of the Canadian Department of Communications. Le présent appareil numérique n’emette pas de bruits radioélectriques dépassant les limites applicables aux appareils numeriques de la class A prescrites dans le Reglement sur le brouillage radioelectrique edicte par le ministere des Communications du Canada.

© 2020 All rights reserved.

For the most recent version of this manual please visit [http://www.IColorprint.com/support](http://www.IColorprint.com/support)
# Table of Contents

## Section 1: Getting Started

1A. Choosing a Good Location .............................................................................................................. 4
1B. Unpacking and Inspection ............................................................................................................... 5
1C. Installing the Roll Holders ............................................................................................................ 6
1D. Identifying the Parts ....................................................................................................................... 10

## Section 2: Media, Cartridges and Knives

2A. Label and Roll Specifications ........................................................................................................... 13
2B. Installing Digital Die-Cutting Label Stock ...................................................................................... 17
2C. Installing Pre-Die-Cut Label Stock .................................................................................................. 20
2D. Replacing the Digital Die Cutting Knife holder ............................................................................. 24
2E. Replacing the Cutting Knife ........................................................................................................... 26
2F. Replacing Ink Cartridges ................................................................................................................ 27
2G. Adjusting the Gap Sensor Position (Pre-Die-Cut Labels Only) ...................................................... 30

## Section 3: UNINET IColor PrintHub

3A. Adjusting Knife Pressure and Stretch Factor ................................................................................ 33
3B. Using the Cost Estimator .............................................................................................................. 35
3C. Set the Gap Sensor Mode (Pre-Die-Cut Labels Only) .................................................................. 36
3D. Set the Present/Cut Mode .............................................................................................................. 38
3E. Adjusting Print Alignment ............................................................................................................. 40
3F. UNINET IColor PrintHub Settings .................................................................................................. 42
3G. UNINET IColor PrintHub Printer Settings ..................................................................................... 42
3G1. Multiple Printer Support .............................................................................................................. 43

## Section 4: Printing and Cutting with IColor CustomCUT Software

4A. Overview IColor CustomCUT .......................................................................................................... 45
4B. IColor CustomCUT Software Activation ....................................................................................... 48
4C. Tutorial: How to Setup a Print and Cut using IColor CustomCUT – Vector File Cut .................... 49
   4C1. Choosing a Label Size (Page Layout) ...................................................................................... 49
   4C2. Import a Vector Image (PDF, AI, EPS, SVG) .......................................................................... 50
   4C3. Working with Layers in an Imported Vector File ..................................................................... 53
4D. Tutorial: How to Setup a Print and Cut using IColor CustomCUT – Contour Cut ....................... 55
   4D1. Choosing a Label Size (Page Layout) ...................................................................................... 55
   4D2. Import an Image ....................................................................................................................... 56
   4D3. Trace Image and Create Cut Line ............................................................................................. 59
   4D4. Offset Cut Path ......................................................................................................................... 62
Section 1: Getting Started

Say hi to the most versatile and lowest-priced label ink-based printer + die cutter all-in-one solution in the marketplace.

The UNINET IColor 250 is a Desktop ink-based, full color, built-in full die cutter, and full steam ahead for short-run professional label production like you’ve never experienced before.

The IColor 250 is packed with the IColor CustomCUT Software, which means you don’t just cut labels; you model them into your desired shape. This Software includes a robust set of tools to properly layout prints and die-cuts for your UNINET IColor 250 printer. It features capabilities to cut standard label shapes, create contour cuts, import a wide variety of file formats, advanced design tools, and more.

Also, the UNINET IColor 250 comes with superb versatile capabilities for Print only, Cut only or Print and Cut functions, and equipped with an all-in-one high capacity single ink cartridge technology with built-in print-head (cyan, magenta, yellow, process black) for both pigment and dye-based applications.

This User’s Manual is your complete step-by-step guide to quickly and easily setting up and printing with your new IColor 250 Label Printer!

For Windows PC only.

1A. Choosing a Good Location

• Place the printer on a flat surface in a location with adequate air circulation to prevent internal heat buildup.

• Do not place the printer near heat sources such as radiators or air ducts, or in a place subject to direct sunlight, excessive dust, mechanical vibration, or shock.

• Allow for adequate clearance in front of the printer to accommodate the printed label stock as it is leaving the printer to avoid the possibility of binding or jamming of the label stock.

• Allow for 6” of clearance behind the printer to accommodate loop creation during cutting operations. The area directly behind the printer must also not be obstructed by USB or power cables connected to the printer.

• Allow for adequate overhead clearance for opening the top cover to allow easy access to the labels tock and ink cartridge. The printer will require 7 inches (17.78 cm) of additional space on the top side to completely open the cover (Total = 16.5” or 41.91 cm).
1B. Unpacking and Inspection

While unpacking your printer, inspect the carton to ensure that no damage has occurred during shipping. Make sure that all supplied accessories are included with your unit. The following items are included in the supply box:

1. Power Adapter and Cord
2. 6’ USB Cable (If another USB cable is used, it must be 6’ (2 M) or less)
3. Color Dye Ink Cartridge - Pigment is also available
4. Die Cutting Knife Holder with knife preinstalled
5. Label roll holders (Assembly required – section 1C)
6. Large Roll Hub
7. Small Roll Hub
8. T8 Allen Key and two screws
9. Printed documentation
1C. Installing the Roll Holders

Some light assembly is required before operating the printer. Follow these instructions to install the roll holders.

1. Set the printer on its front so the bottom is facing you.

2. Install the movable label roll holder by attaching the hooked end on the rail. The bottom of the holder will fit in the notch on the printer.
3. Slide the Roll Holder to the far right.

4. Install the roll guide by attaching the hooked end to the rail. The bottom of the holder will fit in the notch on the printer.
5. Slide the Guide to the stop.
6. Locate the remaining roll holder with the protruding wire. Connect the wire to the port on the printer. Tuck the wire inside the cavity.
7. Snap the holder in place so the two screw holes line up with the holes on the printer.

8. Install the T8 screws using the INCLUDED Allen key or a Torx T8 screwdriver.

9. Rotate the printer back on its feet.
1D. Identifying the Parts

This illustration shows the printer from various angles so all important parts can be identified.

The **Power LED** indicates that the printer is on and ready to receive print jobs.

The **Ink LED** will illuminate when a cartridge has 10% or less of its ink remaining.

The **Pause Button** is pressed to pause a job to allow for the loading of label stock and ink cartridges.

The printer pauses after the printing of the current label has finished.
The **Feed Button** is pressed to load label stock if the printer does not automatically detect the stock. When a stock is loaded each press of the button will cause one label or a few inches to be fed through the printer.

The **Unload Button** is pressed to unload label stock after you receive an End of Roll message in UNINET IColor PrintHub. The printer will reverse the label stock through the feed area.

---

**Interior**

![Interior Diagram]

- **Die Cutting Carriage**
- **Die Cutter Ribbon Cable**
- **Upper Guide Shaft**
- **Print Carrier Ribbon Cable**
- **Print Carrier**
- **Knife Collar Handle**
- **Die Cutting Knife**
- **Lower Guide Shaft**
- **Pre-Die-Cut Rollers**
- **Wear Strip**
- **Die Cutting Pinch Rollers**
- **Cutter Wheel Mechanism**
Back

- Infeed Area
- Gap Sensor Adjustment
- Movable Throat Guide
- Power Switch
- USB
- Power
- Fixed Roller Holder w/ Chip Reader
- Fixed Guide
- Movable Roll Holder
Section 2: Media, Cartridges, and Knives

2A. Label and Roll Specifications

Two types of media can be used.

1. Digital Die-Cut Labels. If you are using the printer to digitally die-cut your desired shapes and sizes only UNINET label stock is recommended. This media comes from UNINET with a smart chip that identifies the media, tracks the percentage remaining, and automatically sets the sensor type to continuous. You will know it is installed when you see the Digital Die-cut Media percentage in the upper right corner of UNINET IColor PrintHub. If you do not see this indication, the digital die cutter will not be enabled and you will not be able to cut shapes.

The following media types are currently available from UNINET. We will be adding more as additional types are discovered, tested, and validated.

<table>
<thead>
<tr>
<th>SKU</th>
<th>Media</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IC475X150HG</td>
<td>High Gloss BOPP</td>
<td>Durable Synthetic Polypropylene Media, 150 ft</td>
</tr>
<tr>
<td>IC475X150PG</td>
<td>Premium Gloss Paper</td>
<td>Premium Paper Media, 150 ft</td>
</tr>
<tr>
<td>IC475X100MM</td>
<td>Magnetic Material</td>
<td>White Gloss Magnetic Media, 100 ft</td>
</tr>
</tbody>
</table>

Other media cannot be used even if you take the chip from new/old UNINET media for the following reasons:

- Old chips cannot be reused once they reach 0% remaining.
- Other media has a liner that may be too thin. The liner on UNINET media is specially created for our printer to prevent cut through to the wear strip.
- The dust created from cutting through the inkjet printable topcoat can be excessive on some media. This can cause frequent print cartridge clogging and other problems.
2. **Pre-Die-Cut Labels.** A wide variety of pre-die-cut label stock can be used in the printer. This media has the shape already cut on the roll before you load it into the printer. These are available from UNINET. Refer to the specifications and settings in the following sections before ordering custom stock from UNINET.

**Important!** Test all custom-made label stock with the intended printer before ordering large quantities! UNINET will only assume responsibility for custom label stock ordered from UNINET.

---

**Label Sensing Methods**

**Method 1:** Label Gap Sensing

**Method 2:** Through-Hole Sensing

**Method 3:** Reflective/Black Mark Sensing (Black Mark must be printed on back side of label stock)

Note: See table below for Max and Min values in inches and mm.
<table>
<thead>
<tr>
<th></th>
<th>Max</th>
<th>Min</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Label Width</strong></td>
<td>5” (127mm)</td>
<td>0.5” (13mm)</td>
</tr>
<tr>
<td><strong>Liner/Media Width</strong></td>
<td>5.125 (130.17mm)</td>
<td>2” (50.8mm)</td>
</tr>
<tr>
<td><strong>Label Height/Length</strong></td>
<td>12” (305mm)</td>
<td>0.5” (13mm)</td>
</tr>
<tr>
<td><strong>Gap Between Labels</strong></td>
<td>10” (253mm)</td>
<td>0.10” (2.5mm)</td>
</tr>
<tr>
<td><strong>Width of Through-Hole</strong></td>
<td>0.5” (12.65mm)</td>
<td>0.25” (6.325mm)</td>
</tr>
<tr>
<td><strong>Gap Sensor Adjustment Range (from right edge)</strong></td>
<td>2.05” (52mm)</td>
<td>0.40” (10.16mm)</td>
</tr>
<tr>
<td></td>
<td>(see diagram below)</td>
<td></td>
</tr>
<tr>
<td><strong>Reflective/Black Mark Width</strong></td>
<td>N/A</td>
<td>0.1” (2.54mm)</td>
</tr>
<tr>
<td><strong>Max Outer Diameter (OD)</strong></td>
<td>6.0” (152.4mm)</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Inner Core Diameter (ID)</strong></td>
<td>3.0” (76.2mm)</td>
<td>3.0” (76.2mm)</td>
</tr>
<tr>
<td><strong>Recommended Total Thickness (Liner + Label)</strong>**</td>
<td>.0010” (10 mil)</td>
<td></td>
</tr>
<tr>
<td><strong>Distance from Edge of Media to Edge of Label</strong></td>
<td>The printer assumes a 2mm (1/16”) gap. However, this is adjustable via the left margin offset.</td>
<td></td>
</tr>
</tbody>
</table>

* The Reflective/Black Mark should be opaque to infrared light. The mark should be between the labels. The end of the mark should correspond with the beginning of the label.

** This is the recommended maximum. Two factors determine whether the printer will accept any particular stock thickness:

1. The ability of the printer to pull the paper through the print area.
2. The ability for the sensor to read through the backing if the sensor is set to die-cut.

If you are printing in continuous or reflective label sensing mode number 2 does not apply. The fact that the printer must read through the backing in die-cut mode will limit the thickness much more than the printer's ability to pull the paper through the print area. However, if you adjust the opacity level of the liner enough to allow the label to be seen by the stock sensor, the thickness will only be limited by the printer's ability to pull it through the printer area. For these reasons, the weight or thickness of the liner is a variable that cannot easily be defined. UNINET recommends and uses 40# liner with all pre-die-cut label stock.

It is important to test all label stock with the intended printer before ordering large quantities!

Gap Sensor Position Indicator from right edge of media. The position indicator corresponds to the ruler NOT the installed label stock.
**Roll Specifications**

![Diagram of roll specifications](image)

**Note on Label Orientation:** If you are using an applicator to apply your labels, be sure to order label stock with the correct orientation for your applicator. For example, most applicators will apply the side of the label first, so you will want to print the labels sideways.

**Digital Die Cut Media Notes:** Even though the width of the media is 4.75 inches, the drive rollers on either side prevent printing in the areas indicated. The knurled rollers that bite into the media to drive it, damage the printable surface in this area. The actual printable area is 4.25 inches.
2B. Installing Digital Die-Cutting Label Stock

1. Move the roll holder to the preset position for on-demand digital die-cutting (3rd mark from the left – 1.25”)

Move to third mark from Left

2. Install the Blue Hub on the open side of the digital die-cutting media.

Note: The green hub is not needed for digital die-cutting and can be stored in the notch on the movable holder.

Digital Die-Cutting Media comes with black hub with green chip.

Blue Hub
3. Set the roll in place so that the blue pin sits in the notch on the roll holder.

4. Make sure the green chip holder fits in the corresponding green slot on the roll holder.
5. Before feeding the label stock, you must plug-in power and switch on the printer.

6. Guide the leading edge of the roll into the feed area. Move the blue guide to the far side.

7. Push until the printer detects the stock, grabs it, and pulls it through the printer.
2C. Installing Pre-Die-Cut Label Stock

1. Move the roll holder to the approximate position which matches the width of the label stock you are installing. You can always fine-tune this later.

2. Install the Green Hub on the right side of the pre-die-cut media.
3. Install the Blue Hub on the left side of the digital die-cutting media.

4. Set the roll in place so that the blue pin sits in the notch on the roll holder.
5. Make sure the green blank chip holder fits in the corresponding green slot on the roll holder.

6. Before feeding the stock, you must plug-in power and switch on the printer.
7. Guide the leading edge of the roll into the feed area. Move the blue guide so that it touches the label stock.

**Note** the position of the label sensor. Slide the sensor position indicator so that it intersects with the gaps between your labels. For most label stock you will not need to move this.

8. Push until the printer detects the stock, grabs it, and pulls it through the printer.
2D. Replacing the Digital Die-Cutting Knife holder

Install the included die-cutting knife shown here.

1. Open the Cover.

2. Pull out on the blue handle to loosen the knife collar.
3. Install the knife holder.

4. Push on the knife so it goes all the way down before pushing the collar in.

5. Push the collar to tighten the knife holder and allow it to cut.
2E. Replacing the Cutting Knife

When a knife is dull it will no longer cut through the label at maximum pressure. You will start to see ragged cuts or cuts that do not cut through the label material. You can attempt to increase the pressure but you'll probably need to replace the knife.

If a knife cuts through the liner and contacts the wear strip it may break the tip of the knife. This can be seen under 10x magnification using a loupe or magnifying glass. If the tip is broken the knife must be replaced.

If your knife needs replacement, follow this procedure:

1. Remove the knife holder from the carrier using the instructions from section 2D.

2. Rotate the cap of the knife holder counterclockwise.

3. Remove the knife from the holder. You can tap the holder on a hard surface to free the knife from the holder.

4. Locate a new knife. Remove the molded plastic cover from the knife. The plastic cap covers the cutting end of the knife. However, both sides are sharp. The cutting end has an angled carbide tip. The top-end comes to a point so it can be easily centered in the receiving pivot on the knife holder cap.

5. Insert the cutting end into the knife holder.

6. Using the knife holder cover, center, the back end of the knife in the holder. You may need to screw down the cover and reverse it several times until the knife has been centered. Do not force the cap on the holder. The carbide tip will break. A very slight amount of force is necessary to secure the knife holder cap.
2F. Replacing Ink Cartridges

You can replace cartridges at any time or wait for the Low Ink Warning to prompt you to replace cartridges. You will receive low ink warnings at 10% and 0%. Press the Load/Feed button to continue printing after you receive this warning.

To change a cartridge, follow this procedure:

1. Open the front cover. That cartridge will automatically move to the right side if it is not already there.

2. Press or pinch the tab on the front of the cartridge holder.

3. Remove the cartridge.
4. Locate a new cartridge and remove it from its packaging. Remove the foil outer package and the tape covering the nozzles.

5. Place the new cartridge into the empty carriage. Note: When installing the cartridge, tilt the cartridge at a slight backward angle of approximately 30 degrees.
6. Make sure the cartridge is pushed back far enough so the ridge on the cartridge is behind the spring-loaded pusher on the lid. **Push down on the cartridge.** Close the lid on the cartridge by lightly pressing down from the top until you hear a click.
2G. Adjusting the Gap Sensor Position (Pre-Die-Cut Labels Only)

If you are using label stock other than standard square / rectangular die-cut labels, such as circular die-cut labels or through-hole stock, use the instructions below to adjust the position of the label stock gap sensor. The sensor can be adjusted using the slide bar on the back of the printer. Below the slide bar is a measurement that represents the distance between the edge of the label stock and the sensor. Measure the distance from the edge of the label stock to the correct position on the label stock. Set the sensor so the side of the slide bar lines up to this measurement. See the dashed line in the illustration below.

![Diagram showing adjustment of gap sensor](image)

**Important Note** You must adjust the stock sensor before loading nonstandard label stock.

Circular Labels

If you are using Circular Labels you must adjust the stock sensor to correspond with the very top of the label where the circles are closest together. If the sensor is too far to the right or the left, the printer will still sense the label but the image may be offset downward because the printer will start printing in the wrong position. If you are using stock that has multiple labels across, make sure the sensor corresponds to a place on the stock that has a label and not a vertical gap.
The sensor can only be moved a maximum of 2 inches from the left side of the printable area. This means that the maximum diameter circular label that can be printed is 4 inches. For circular labels larger than 4 inches in diameter, you must have a black mark printed on the back of the label stock. This means that you must change the Stock Sensor Mode to Reflective. The printer will now look for the black mark representing the beginning of the next label instead of the die-cut.

For more information on changing the Stock Sensor Mode, see section 3C.
Section 3: UNINET IColor PrintHub

UNINET IColor PrintHub is used to interact with the printer for gathering ink levels, maintenance, alignment, cost calculation, and several other functions. UNINET IColor PrintHub automatically installs with your printer driver and can be accessed through the printer driver preferences or as a program on your Windows start menu.

1. Connect the printer via USB and turn on the power. The UNINET IColor PrintHub accesses most of the information it uses from the printer itself so the printer must be turned on and communicating for the program to be useful.
2. Go to Start / Programs / UNINET IColor Technology / UNINET IColor PrintHub.

A. Adjust alignment, sensor mode, output mode, and advanced settings.
B. If you have multiple UNINET printers connected, they will be listed here.
C. Past jobs will show the last 5 jobs along with cost information. Click the document icon to view a cost report.
D. Application Settings
E. Print Queue shows the currently printing job.
F. Frequent Activities
G. Current Ink Levels (Ink is displayed in 10% increments. For example, 100% to 90% to 80% etc.)
H. Digital Die-Cutting Media Status and Remaining Amount (If installed)
3A. Adjusting Knife Pressure and Stretch Factor

Knife Pressure and Stretch Factor settings can be found in UNINET IColor Print Hub on the Printer Settings Tab for the IColor 250. Click the Advanced Settings button to view these settings.

Knife Pressure affects how deep into the media the knife will cut. Ideally, you want to cut deep enough to cut through the label layer on the top but not so deep that you cut through the backing paper (liner). When you cut through the backing paper your label will not peel cleaning off the backing paper. You will also score the wear strip under the cutting knife which can cause the knife tip to break. You will also need to replace the wear strip more often if you cut too deep.

By default, the cutter is calibrated to work with High Gloss Paper Media. However, other media types will need more or less cut pressure to cut properly.

Each roll of media will have a recommended value to add or subtract from the default baseline values used for Knife Pressure and Knife Stretch Factor. These values are listed below and printed on a label attached to the inside of the core.
<table>
<thead>
<tr>
<th></th>
<th>Knife Pressure</th>
<th>Stretch Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Gloss Paper</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>High Gloss BOPP</td>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>Magnetic</td>
<td>22</td>
<td>32</td>
</tr>
</tbody>
</table>

Knife Stretch Factor can be increased or decreased to compensate for different feed thicknesses and textures of media. Thickness and texture can affect the feed speed of the media usually causing it to feed more slowly than the baseline media (High Gloss Paper). This will cause the height/length of your cut to be shorter. If you find that your cut height/length is longer or shorter than the height specified in the IColor CustomCUT software, you may need to increase or decrease the stretch factor. Increasing this value will create a longer cut. Decreasing it will create a shorter cut.

**Adjusting Knife Pressure over time.**

Eventually, the knife blade will begin to wear and require more cut pressure to cut at the same depth as when it was brand new and sharper. Therefore, you may need to add cut pressure when cutting any media even the High Gloss Paper.

To determine if cut pressure needs to be increased or decreased, follow these steps.

1. Print and Cut one copy and then attempt to peel the label from the liner.
2. Check for tear. If the label tears when you remove it, you will need to increase the cut pressure. Increase pressure in small increments to avoid overcompensating and cutting through the liner.
3. Check the liner. Once you peel up the label, check the liner. If it has been cut through, decrease pressure.
4. Continue increasing or decreasing pressure until the label no longer tears when removed or the liner is not cut through.

**Note about Magnetic Media:** The recommended starting knife pressure for the magnetic media is 22. This media is not meant to be cut all the way through because there is no liner. Instead, this knife pressure setting is meant to score the magnetic media so that it can be removed by hand after printing. In some cases, it may be necessary to tear the outer excess material from the intended shape.

If you do cut through this media, it can damage the wear strip, break the knife tip, or cause media jams.
3B. Using the Cost Estimator

The cost estimator is found under the queue section on the first tab of the UNINET IColor PrintHub. The last five job costs are stored in the list. Each job will show the cost per label based on the cost per cartridge entered below the list. Enter the actual cost of the cartridge you paid. Prints remaining on the currently installed cartridge and total prints on the new cartridge are both displayed.

To see a printable/savable report click on the document icon next to the job you want to see. A report will display the information. You can print or save the report from this screen. You can also change the currency using the drop-down, change the job name, or adjust the cost from this screen.
3C. Set the Gap Sensor Mode (Pre-Die-Cut Labels Only)

The stock sensor mode refers to the method the printer will use to detect the print starting position for each label. To adjust the stock sensor mode, open the UNINET IColor PrintHub. In most cases, you will NOT need to change this setting. By default, it is set to sense standard Pre-die-cut labels. It is only necessary to change this setting if you are using clear labels or any label with a black sensing mark on the back. When you install Digital Die-Cutting Label Stock this setting will automatically be set for you.

1. Connect the printer via USB and turn on the power. The Stock Sensor Mode setting is stored in the printer's internal memory so you will not be able to access it unless the printer is turned on and properly communicating with the computer.
2. Go to Start / Programs / UNINET IColor Technology / UNINET IColor PrintHub.
3. Click on the Label Feed (3rd tab from left).
4. Select the Stock Sensor Mode by clicking on the graphic that most closely corresponds to the stock you intend to install.
5. Load the label stock after you have set the sensor mode.
There are three sensor modes:

**Die-Cut (Default).** If you are using standard die-cut labels that look similar to the graphic, use this setting regardless of the size of the label. Also, use this setting for Through-hole label material where a hole is punched through each label or a notch is cut in the side.

**Reflective.** Use Reflective for label material where a black pre-printed line (black mark) on the back of the label stock indicates the break between labels. Black marks are required on clear label stock rolls or label where the label waste matrix (waste) is left on the liner. Black marks can also be used for irregularly shaped labels, circles larger than 4 inches, or on any stock where the print starting position cannot be sensed using the label itself.

**Continuous. (Sensor off)** If you have continuous stock with no die-cut, reflective mark, or holes, set the sensor type to Continuous. This will turn off the stock sensor. In this mode, there is no way to set the print starting position. The printer will simply start printing the first label and print each subsequent label immediately after that previous one. To produce a gap between prints simply add the desired amount of white space to the end of the label being printed. The printer will automatically switch to this setting when Digital Die-Cutting Label Stock is installed.

**Important Note:** You must also set the Stock Sensor Position (Section 2G)
3D. Set the Present/Cut Mode

Use the Present/Cut Mode to adjust how the printer presents labels after they are printed or if/when they are cut after printing. To adjust the Present/Cut Mode, open the UNINET IColor PrintHub program.

1. Connect the printer via USB and turn on the power. The Output/Cut Mode Setting is stored on the printer's mainboard so you will not be able to access it unless the printer is turned on and properly communicating with the computer.
2. Go to Start / Programs / UNINET Technology / UNINET IColor PrintHub.
3. Click on the Label Feed Tab.
4. Click on the Output/Cut Mode button. There are different options available which change if the Cutter is enabled or disabled. If the Cutter is disabled, the label present options will be available. If the Cutter is enabled the present options are no longer available but cut options become available.

Cutter Options

Cut after the button press. This setting will cut after you press the Load/Feed button on the printer. This can be used after one label or an entire job. This feature is useful if you will not be present at the end of the print to catch the cut label.

Cut after label count. This option will cut after the number of labels specified in the toggle box that appears when this option is selected. This is useful if you have front/back labels or sets of labels.
Cut after no activity. This setting will cut at the end of a print job if the printer does not receive another print job within one second of the last print job in the queue. You can use this feature to cut at the end of a multi-copy job, multi-page job, or multiple individual jobs in the queue.

Cut every label. This setting will cut after every label.

Present Options

Do not present. In this mode, the label stock does not move after the last label is printed. This means that part of the last label printed is still in the printer. This should be used only if you have a label rewinder attached.

Present after no activity. This setting will present (feed all printed labels past the front opening) at the end of a print job if the printer does not receive another print job within one second of the last print job in the queue. You can use this feature to present at the end of a multi-copy job, a multi-page job, or multiple individual jobs in the queue.
3E. Adjusting Print Alignment

If your previous experience with printing is limited to printing letters and cards to 8.5” x 11” paper you probably are not familiar with an essential part of label printing - Print Alignment. Standard printers feed a sheet and start printing based on the start of the sheet. They also prohibit printing to the edge of the sheet. This is to avoid any need for alignment.

The IColor 250 senses the beginning of the label with an optical sensor and is capable of printing to top, bottom, left, and right edge. Because of this, it is necessary to align the printer to work with specific types of label stock.

The IColor 250 comes factory calibrated to print exactly to the edge of UNINET label stock. However, due to variations in the left margins and other variables, it may be necessary to fine-tune these settings at the beginning of each roll. This is especially true for other non-UNINET brand label stock.

Adjust print alignment using the UNINET IColor PrintHub. Go to the Print Alignment Tab (second tab).
Click on Test Alignment to print the alignment shown to the right. Look at the print to determine how much white space is visible on the edges. The black lines should print right on the leading edge and left edge. In this example, the Top of Form needs approximately -10.

1. **Left Margin Offset.** This value moves the printed label left or right. Add to the current value to move the printed label to the right. Subtract from the current value to move the printed label to the left.

2. **Top of Form (TOF).** This value moves the print start position up or down on the label. Add to the current value to move the printed label down or toward the printer. Subtract from the current value to move the printed label up or away from the printer.

The value is automatically saved as soon as you set it. You may have to make several adjustments to one or more of these values. After each adjustment, you can click the Test Alignment button to print a small test pattern on the label. This will help you find the proper alignment value.

3. **Tear off/Cut Position.** This value adjusts the position of the last label printed after it has been presented. This only applies if the output mode is set to "Present the label." Add to the current value to move the tear point closer to the printer. Subtract from the current value to move the tear point away from the printer. The value is automatically saved as soon as you set it.
3F. UNINET IColor PrintHub Settings

1. General application settings that apply to the software and all printers can be found by clicking the blue “Settings” button in the lower left. Printer specific settings can be found on the “Printer Settings” Tab. See the next section.

2. Language. Typically, the language is set to match the language setting in the operating system. However, you can override currency settings on the Language Tab.

3. Printing Preferences. You can choose to close UNINET IColor PrintHub after printing completes by checking the “Close this application after printing completes” box. UNINET IColor PrintHub automatically opens whenever you send a print job to the printer. If you do not want UNINET IColor PrintHub to open in front of other programs, you can check the “Launch minimized during print” option.

4. Support. Click the “Generate Support Report” button to generate a zip file on your desktop containing all recent log files. Send this to tech support so they can help solve any printing problems.

3G. UNINET IColor PrintHub Printer Settings

Printer settings can be found in UNINET IColor Print Hub on the Printer Settings Tab for the IColor 250.

Information. This section displays all current drivers, software, and firmware versions.

Advanced Setting Button. Click the Advanced Settings button to view the following settings.
General Settings

3G1. Multiple Printer Support

You can install multiple printers to the same computer and use them simultaneously. To do so you will need to change the USB serial number identifier of one of the two printers, two of three printers, three of four printers, etc. To change serial numbers:

1. Connect each new printer one at a time. The current USB Serial Number will be displayed.

2. Click Generate. It will find the next available USB Serial Number based on the currently connected printers. For the first one, it should set it to 2 and for the next printer 3 and so on.

3. Click Set. You will hear the printer reset and the settings window will turn gray. After it resets you will be able to see the settings window again. Keep the printer connected.

4. Now you can connect the next printer. Windows will automatically install a new driver for that new printer and name it IColor 250 (Copy 1). You can rename it later by editing the printer properties in the Windows printer list.

5. You will now see a second printer appear in the left column – IColor 250 (Copy 1). Click on it to display information about this printer. If this is the last printer, you will connect you are done. If you wish to connect additional printers follow-through steps 2-4.
**Restore Factory Defaults.** This will set all Print alignment and other calibration settings back to factory defaults.

**Cartridge Settings.** Here you can adjust the frequency of certain maintenance operations. Increasing the value of “Seconds between Maintenance Spits” will decrease ink usage but could also cause poor quality printing.

Increasing of Pages between Maintenance Wipes will speed up printing but could also cause poor quality printing.

Check the Suppress Alignment message to prevent the window from appearing which prompts you to align the cartridge every time a new cartridge is installed. Skipping the alignment is faster but can result in poor print quality.

**Stock Feed Settings.** Adjust these settings only if directed to do so by Tech Support. Calibrate the paper sensor if you are receiving TOF errors. The calibration process will prompt you to remove all paper/stock from the printer before calibrating.
Section 4: Printing and Cutting with IColor CustomCUT Software

IColor CustomCUT Software is everything you will need to layout your prints and cuts for your IColor 250. Every object that you place in your layout can be set to print only, cut only, or Print and Cut.

4A. Overview IColor CustomCUT

1. **Layers.** Layers allow you to see and manipulate layers of imported SVG files or elements added within IColor CustomCUT. SVG files can be created in programs like Adobe Illustrator.

2. **Import.** Allows you to import flat files and Vector files like AI, EPS, and SVG which can be a graphic you would like to print, a cut file, or both in the same file.
3. **Trace** Allows you to create a cut file by tracing a JPG, BMP, or TIF, or other flat files that you have imported. This is a great option for creating complex cut files without needing another expensive and complex design program.

4. **Advanced Design Tools.** Advanced design tools such as Gradient, Eye Dropper, Eraser, Freehand drawing, and the Shape Node Tool allow you to create your desire design in IColor CustomCUT.

5. **Document, Position & Size, Fill & Stroke, Style, Text.** These tabs all manipulate existing objects on the page. The document controls the artboard or page size. Position & Size allows you to precisely move objects on the page. Fill & Stroke allow you to change the color of the lines. The Style allows you to change whether a particular object should be cut, printed, or both. The Text allows you the change font and size of text objects.

   ![Document and Position & Size dialog boxes]

   a. **Document.** Use this tab to adjust the page size after it has already been setup. Sometimes you may need to increase the height of the page to accommodate a bleed or multiple rows.

   b. **Position & Size.** You will use this tab to move both the cut line and the image on the page. It is much easier than trying to drag and drop images manually.
c. **Fill & Stroke.** Use this to change the line style of the cut. For the most part, you should leave these settings at their defaults. If you are having trouble seeing your cut line, you can change the color of it here.

d. **Style.** Here you can designate whether any object should be Print, Cut, or both. By default, all images imported using the import icon will be set to Print. Also, all objects drawn using the rectangle or circle tool will be set to Cut. However, this tab will allow you to adjust this if necessary.

e. **Text.** The text tab allows you to adjust the font, size, and other properties of text. Text can be added using the Text tool from the left side toolbar.

6. **Library.** The library contains some preset shapes that you can apply to your document as cut objects or print objects.

7. **Page Layout.** This area shows your actual image. You can move objects here by clicking and dragging. You can also see where the cut will be made with your print. In the example above the cut, the line is highlighted red and inset (overbled) slightly so there will unprinted area on the label.
4B. iColor CustomCUT Software Activation

You will need to activate the iColor CustomCUT Software and will be sent an activation code in your purchase confirmation.

To Activate, follow the activation prompt that appears when you open the software or go to the Help Menu – Activate.

iColor CustomCUT Demo Mode

"iColor CustomCUT" will run in Demo Mode until the software is activated with a valid Activation Code.

In Demo Mode:
- Cutting is disabled

An activation window will appear. Enter the activation code with the dashes included. Click OK.

The software is now activated on this computer.

Important Note: Activation requires internet access!
4C. Tutorial: How to Setup a Print and Cut using IColor CustomCUT – Vector File Cut

If you have a designer that can use an advanced program like Adobe Illustrator or Corel Draw, you can save your print file and cut the file together as a multi-layer vector file in AI, EPS, or SVG format. You can then import them into IColor CustomCUT and designate which layer will be the cut and which will be the print. This will allow you to create complex cuts in exactly the right shape and exactly the right position. This method is the best way to get the highest quality print and cut. While tracing the image using the steps in the previous section will allow you to create the same shapes, you can save time and create a smoother cut file using this method.

Important Note: Before you start with IColor CustomCUT, your designer should create the print and cut line together and save them as two separate layers in the same file. You’ll be able to see these layers when you import the file into IColor CustomCUT.

4C1. Choosing a Label Size (Page Layout)

After you activate your software you will be prompted to open or create a new project.

1. Choose New Project...

2. Set your page size. Since all die-cutting media is 4.25” wide the standard maximum width is automatically set to 4.25. In this example we have set the size to 4.25 x 6 to accommodate approximately a 4” x 6” label.

Tip! Set your page larger than the label size to be cut. This will allow you to create a bleed around the label so that you always cut inside your print and get perfect cut every time.
3. To set the page height or width to a custom size type the size in the W: and H: boxes or toggle the size up or down with the arrows.

4C2. Import a Vector Image (PDF, AI, EPS, SVG)

The IColor CustomCUT Software allows you to import vector files for printing and cutting. You can import the following vector image formats: PDF, AI, EPS, SVG

To import an image for printing follow these steps.

1. Go to the File Menu or shortcut bar, choose Import.
2. Browse to the file you would like to use and choose Open.
3. The file will appear on your page layout. You can manually move it on your page or increase the size. However, a better option is to use the Position & Size window. Set the size to match the size of the page layout. In this case center the image to the page.
4C3. Working with Layers in an Imported Vector File

Once you have imported the vector file you view the layers in the layers window. The cut file must be separated from the design at the top level. It cannot be buried under other layers that will be printed. In this example, the cut line layer is setup in Illustrator as an Outline instead of a Fill.

Either will work but Outline is preferable.

4. To view the sublayers and find the cut line, click on the arrow to open up the group.

Note: Before printing we recommend clicking the print Preview Button described in section 4H.
5. Once you find the cut line, select that layer, and click the style tab above.
   A. Choose Cut Only.
   B. Set Style to Blackout.

6. Now select the Print layer, click on the style tab above, and choose Print Only.

7. To print go to the File menu and choose Print or click the Print Icon on the shortcut bar. The print dialog will appear. Make sure Print+Cut is selected. Click the Properties button to access the printer settings such as Print Quality, Saturation, and Color Matching. For a full explanation of printer driver settings see section 5D.
4D. Tutorial: How to Setup a Print and Cut using IColor CustomCUT – Contour Cut

This tutorial will walk you through the basic steps to print and cut a label using the trace image/contour cut feature found in IColor CustomCUT.

4D1. Choosing a Label Size (Page Layout)

After you activate your software you will be prompted to open or create a new project.

1. Choose New Project...

   ![New Project Options]
   
   - **New Project:** Click "New Project" to start a new blank project with default settings.
   - **Open Project:** Click "Open Project" to continue working on an existing project.
   - **Recovered Projects:** Continue working on recovered projects.

2. Set your page size. Since all die-cutting media is 4.25" wide the standard maximum width is automatically set to 4.25". In this example we have set the size to 4.25" x 4.25" to accommodate approximately a 4” x 4” label.

![New Project Settings]

   **Tip!** Set your page larger than the label size to be cut. This will allow you to create a bleed around the label so that you always cut inside your print and get perfect cut every time.
3. To set the page height or width to a custom size, type the size in the W: and H: boxes or toggle the size up or down with the arrows.

**4D2. Import an Image.**

IColor CustomCUT allows you to import flat files and vector files. You can import the following image formats: AI, EPS, PDF, SVG, JPG, BMP, PNG, TIF, GIF.

**Important Note:** UNINET recommends imported images are at least 300 DPI. The software is optimized for this size. Larger DPI images can be manually resized. Smaller DPI images will not utilize the maximum quality of the printer and may appear pixelated. Images downloaded from websites are typically made to display only onscreen load quickly so they are typically only 72 DPI.

To import an image for printing follow these steps.

4. Go to the File Menu or shortcut bar, choose Import.
5. Browse to the file you would like to use and choose Open.

6. The file will appear on your page layout.

7. You can manually move it on your page or increase the size. However, a better option is to use the Position & Size window. Set the size to match the size of the page layout. In this case, set the width to 4” and check the Keep Proportions box.
8. Center the image horizontally and vertically to the page.
4D3. Trace Image and Create Cut Line

Tracing the images requires a flat-file such as BMP, GIF, JPG, or PNG.

9. Select the image object that you just imported. This is very important. You’ll know it is selected when the bounding box appears around the image. Now click on the Trace Icon.

10. There are many options available in the Trace Image window. However, the most important option is the Contrast. You should adjust the contrast until the preview shows a single green highlighted image in the shape you would like to cut.
11. Click Update Preview to show the cut lines and the number of points/nodes in your cut file (if you check Show Nodes). These nodes are the points on your image to which the knife will travel to cut the label. Don't worry if your cut line isn't exactly in the right position or size. We'll adjust that later. At this point, you are just looking for smooth lines that represent the correct shape.

12. Note the difference in the preview when you increase and decrease the contrast.
Contrast to High: If contrast is too high you will lose the shape detection and end up with a rectangle cut.

13. Click OK when you are happy with the shape of your cut line. The cut line will appear on top of your image as a red outline. You’ll see a trace layer appear in the layer window.
4D4. Offset a Cut Path

14. Now you'll need to offset the cut line inside your image so that you'll have a bleed. With the cut line selected go to the Path menu and select Offset.

15. On the Path Offset Window, check the Inset Offset box and adjust the amount of offset. For this image, we chose 0.040 inches. You'll see a preview of the new position of the cut line in black.
16. Click OK to change the Offset. The new cut line will appear.

Note: Before printing we recommend clicking the print Preview Button described in section 4F.

17. To print go to the File menu and choose Print or click the Print Icon on the shortcut bar. The print dialog will appear. Make sure Print+Cut is selected. Click the Properties button to access the printer settings such as Print Quality, Saturation, and Color Matching. For a full explanation of printer driver settings see section 5D.
4E. Setup Multiple Identical Cuts (Duplicate and Array)

If you intend to print and cut a smaller label such as a 2” circle, you may want to duplicate that image and cut line across the page so that you don’t waste material. No matter what your label size is, your page size for die-cutting is always 4.25”. It makes sense to fill up that page with as many labels across as you can. Follow these steps to Duplicate images and cut across the page.

1. Create your page size. In this example, we chose 4.25” x 4.25”. You can choose a custom size to fit your labels. In this case, we wanted to choose a height that was able to accommodate 2 rows and two columns of 2.125” x 2.125” cut to 2” x 2”.

2. Import your image using the import icon.
3. Set the Size & Position. In this example, we are setting the size to 2.125” x 2.125”. Center the image horizontally and vertically.

4. Create your cut line using the shape tool on the left side toolbar. Right-click on the rectangle icon and choose the circle tool.

5. Draw the circle close to the size of the images. You don't have to be accurate on this step since we will be changing the size and position in the next step.

6. Set the size to correspond to the actual cut label size you would like. In this case, we set the size to 2” x 2” so that we have a standard 1/16” bleed around the label. Uncheck the Keep Proportions box. This will make sure that no labels have any white unprinted areas around the edges.
7. Center the cut line horizontally to the page.

8. Using the arrow tool select both image and the cut line by drawing a box around them.
9. Group them by going to the Object Menu – Group. This will ensure that the cut stays with the image and in the correct relative location, while we move and duplicate the image in the next steps.

10. Align the group image and cut line to the upper left corner.
11. Now go to the Object Menu and click Duplicate. Make sure the image and cut line are still selected; otherwise, the Duplicate item will not be available.

12. Set the number of rows and columns.

13. Set the gap between the rows and columns. In this case, we are setting the gaps to zero. We already created a bleed so the cuts will not intersect or be too close to each other with zero gaps between prints.

14. To print go to the File Menu and choose Print or click the Print icon on the shortcut bar. The print dialog will appear. Make sure Print+Cut is selected. Click the Properties button to access the printer settings such as Print Quality, Saturation, and Color Matching. For a full explanation of printer driver settings see section 5D.
4F. Print Preview

Before you print you can click the Preview button to verify what objects will cut and what objects will print. Check either Show Cut Lines or Show Printable to see what will print or cut.
4G. Vector File Specifications for Designer

When importing files using the methods described in section 4D please make sure the imported file follows the specifications below:

1. Place the design on a top layer. Place the cut line on another top layer at the same level as the design. Do not bury the cutline inside the design.
2. The cutline should be a compound path set as an outline. Set the color to any color that stands out against the design.
3. Position the cut line exactly where you want it relative to the design. The cut line should be the size of the final label. The minimum over bleed should be 0.040”.
4. The workspace should match the full bleed of the design to be printed.
5. Convert fonts to vector graphics by outlining them. (In Illustrator, select the text - go to the Type Menu - Choose to Create Outlines).
6. Save the design as a vector file in this order of preference. 1. SVG File 2. AI File 3. PDF File.
Section 5: Printing Only to Pre-Die-Cut Labels

If you don’t need to cut custom shapes, the IColor 250 is an extremely capable Pre-Die-Cut label printer. While IColor CustomCUT can print only to the IColor 250, other dedicated printing programs offer some advantages.

5A. Using BarTender for Pre-Die-Cut Printing


When you open BarTender, you will be given the choice to select an existing label or create a new one using a wizard. Use the following instructions as a guide through the wizard setup process.

1. Choose "Start a new BarTender document..."
2. Select "Blank Template". Click "Next".

3. Select "IColor 250 Label". Click "Next".
4. Select "Specify Custom Settings". Click "Next".

5. Set the page size, width and height to match labels installed in the printer. Click "Next". **Important:** Measure the label stock if you are unsure about the size.
6. Select your label shape. This is typically "Rounded Rectangle" for standard labels from UNINET. Click "Next".

7. Set all of the margins to zero. (You can adjust the left margin and Top of Form in the Label Alignment Section). Click "Next".
8. For a standard label set Rows and Columns to 1. Click "Next".

9. Set Template Size to be the same as the label size. Click "Next".
10. Check the "Picture" box to add a background photo or graphic to your label. Click "Next". If you click "Finish", the remaining default wizard options will be set and no picture will be added.

11. Select "Embedded Picture". Click the "File" Button to browse to the location of your photo/graphic file. Set the Size Method to "Stretch". Note the preview to the right. Click "Next" if you are satisfied with the layout of the photo or graphic. Otherwise you may try one of the other Size Methods in the drop-down menu.
12. Review the label setup summary. If it is correct, click "Finish". Your blank label or label with background will be displayed.

You can edit any of these initial settings by going to the File Menu and selecting "Page Setup". Basic and advanced settings are available on the various tabs.
5B. Add Text, Barcodes and Graphics to a Label in BarTender

Once you have created your label size, you will be able to add text, a barcode and/or graphics. This can be done using one of the buttons on the button bar at the top of the screen.

**Add Text.** Click the Text button. Now click anywhere on your label. "Sample Text" will appear. Edit the text on screen or double click it to open up text settings to change font, size and other settings.

**Add Graphic.** Click the Image button. Now click anywhere on your label. An Image icon will appear. Double-click it to open up image settings and browse to the image/graphic that you would like to insert.

**Page Setup.** Click the Page Setup button to change your label size, adjust corner radius or change the shape.

**Add Barcode.** Click the Barcode button. Now click anywhere on your label. A barcode settings window will appear. Here you can choose any type of barcode and enter the value.

**Tip:** Double-click any object to open settings for that object.

**Tip:** Go to the Help menu to access the BarTender Manual and Tutorials.
5C. Printing From Other Programs

Since this printer uses a standard Windows printer driver you can print from any application you would like. There are just a few things to remember that will make it much easier.

1. Set the Page/Label Size in the Driver. BarTender automatically prompts you for the size of the label that you are using. When printing from any other program you must do this manually. Before you print, simply set the custom page size just as you would set print quality in the document properties.

2. Check the image or document size. The image size or document size set in Illustrator should match to the Page/Label Size set in the driver. If you have set your page size to 4" x 4" but your image is 5" x 3" the printer driver will automatically shrink your image to fit inside the 4" x 4" label. The result is that the actual printed label is 4" x 2.4". Avoid this by setting your document size or image size to match the label size.

3. Choose the right printing program. Many different applications are capable of printing to the IColor 250. However, there are only a few that are ideal printing applications. For example, Adobe Illustrator is an excellent design program but is not always the best printing program. It can be difficult to find the printing preferences or to know the exact size of the artboard. It is best to save as a PDF file and print from Adobe Reader or export as a 300 dpi JPG and print from BarTender.
5D. Creating a Full Bleed Print

To create a label that fills the space with no white margins, adjust these settings in the status monitor and printing application (BarTender). This is only necessary if you are printing to Pre-Die-Cut Label stock. If you are printing and cutting using die-cutting media, you can adjust the position of the cut line to accomplish this.

**Page Size.** Increase the page size width by .03 inches (1mm). Increase the height by .03 inches (1mm). If you are using BarTender, simply change the size under the File Menu - Page Setup. If you are using other graphics programs you will need to change the page size in the application and the printer driver preferences.
**Left Margin Offset.** You must decrease the left margin offset to center the over bleed on the label. If you over bleed by .03" you will need to decrease the Left Margin Offset by 0.4mm. This will center the page size increase so there is a .03 inch over bleed on both left and right sides. Some additional adjustments may be necessary if the label was not perfectly aligned, to begin with. See Section 4D.

**TOF.** Increase the Top of the Form by 0.4mm. This will cause the printer to start printing before the label and ensure a fully printed label. Some additional adjustments may be necessary if the label was not perfectly aligned, to begin with. See Section 4D.

**Note:** It is best to over bleed as little as possible to avoid excess ink on the label backing. Also, over bleeding too much will cause the printer to skip labels. This is because the printer stops printing too late to sense the next label.
5E. Printer Driver Settings

Once the printer driver has been successfully installed, you will need to set up the driver with the appropriate print options. Refer to the following steps to change or verify your default printer driver preferences. These settings will apply to all new designs created in other programs after the preferences were changed. Existing labels saved in BarTender will not be affected since the preferences are saved with the label. To change these preferences, you will have to change printer preferences through BarTender. (File Menu - Printer Settings)

Click the Start button, search for "Printers". Select Printers and Scanners. Select the IColor 250. Choose Manage. Select Printing Preferences.

![IColor 250 Label Printing Preferences]

- **Paper Size:** 4x3 in.
- **Orientation:** Portrait
- **Print Quality:** Quality 2
- **Color Matching:** Vivid Photos
- **Ink Saturation:** 85
- **Enable Bi-di Printing:** Yes
- **Launch PrintHub...**
- **Details...**
Note on PC Settings:

Most applications allow you to change these same printer driver options from their "Print" and/or "Printer Setup" screens. Some applications such as BarTender save your settings with the label, others use settings only for the current print job just sent to the printer.

Paper Size
If you are using BarTender, this setting is adjusted during the label setup wizard. If you are using a program other than BarTender you will need to set this to the dimensions of your label. Keep in mind that the dimensions are always relative to the width and height of the actual label in the printer. The orientation of an image on the label should not change this setting. See Section 2A for minimum and maximum label sizes.

Orientation
There are two settings for orientation, Portrait, and Landscape. If your text and graphics print left to right or as shown on the screen, select portrait. If you wish your printing output to rotate 90 degrees from what you see on the screen so it is printing horizontally, select landscape as your orientation. Remember, this does not change the width and height of Paper Size. It is only a tool for viewing a label upright on the screen that will be printed sideways on the printer.

Print Quality
There are 4 levels of print quality in the driver. The lower the quality, the faster the print. Quality 1 provides the fastest print available while Quality 4 provides the best quality. It is recommended that you experiment with the different levels when designing your label to find a good balance between print quality and print speed. Quality 2 is the default.

Color Matching
There are several options available depending on which cartridge is installed (Pigment or Dye). The options will update automatically depending on which cartridge is installed.

Vivid Graphics mode is best used for graphical images where accurate color reproduction is not as essential. Images printed in this mode will look more vibrant because more ink is being used to produce them. However, printing images of people may produce skin tones that have a reddish tint.

Vivid Photo mode is best used for photographic images where accurate color reproduction is very essential. Images printed in this mode will look lighter than those printed in Vivid Graphics mode. Skin tones especially will look more natural in this mode.

ICC Gloss Paper, ICC Gloss Polyester, and ICC Matte Bopp are all ICC calibrated color matching options. Select the setting that corresponds to your installed UNINET media of the same type to produce ICC color-matched prints. Note: ICC monitor calibration and additional setup is required for this option to work.

NONE- will use no color matching.
Ink Saturation
This option controls the amount of ink used when printing an image. The default setting is 100%, which will provide the most accurate color matching. If the ink is not drying fast enough or "bleeding", you can decrease the Ink Saturation to lessen the amount of ink that is applied to the label.

Rotate 180 Degrees
Set this setting to Yes to print with the labels right side up as they exit the printer.

Enable Bi-di
Set to "Yes" for the fastest print speed. Requires an alignment print after every cartridge change. Set to "No" for better quality print (in some cases).

Launch UNINET IColor PrintHub
This setting will open the UNINET IColor PrintHub application.

Details
Select this setting to see current firmware and driver version information and other printer settings.
Section 6: Troubleshooting

6A. Solving Pre-Die-Cut Print Alignment Problems

Image is Vertically Offset (White space can be seen on the top or bottom of the label), the IColor 250 decides where to start printing by detecting the start of a die-cut label, detecting a black mark on the back, or detecting a thru-hole that corresponds to the start of the label. The following items can cause the label sensor to improperly detect the start of a label:

1. TOF Offset. TOF stands for Top of Form and this setting allows you to fine-tune the alignment of your printing on your label stock. This will be factory calibrated. If fine-tuning is needed, increase this setting to move the image down on the label; decrease this setting to move the image up on the label. The unit of measure is 0.1mm.

2. Nonstandard / Non-translucent Backing Material. Test the unit with approved label stock from UNINET (ask tech support to send a sample). If it prints correctly, your label stock may not be compatible. The label sensor needs to see the difference between a label and a backing material by seeing through the label stock for light variations. If it cannot see through the label, problems will arise. If you must use this type of backing, try label stock that has a black mark on the back to show where the label begins. You will need to change the Sensor Type setting in the driver preferences to Reflective if you switch to a label with a black mark on the back.

3. Improper Label Gap Distance. If the gap between labels is too small there will not be enough time for the gap to be detected. See Label Specifications.

4. Page Size is Bigger than Label Stock Size. If the page size set in the driver is larger than the actual label stock, the ink will be printed on the gaps and the sensor will start looking for a gap too late. This can cause label skipping or inconsistent print starting points.

5. Portrait / Landscape. If the Portrait / Landscape setting does not correspond to the label stock installed this will also cause the printer to print over the gap and onto the next label. Make sure this is set correctly.

6. Sensor Position. Circular, nonstandard label shapes or multiple labels across will require precise adjustment of the label sensor. If you are using circular or other non-rectangular die-cut labels see Section 2B for instructions.

The Image is Printing Horizontally Offset
(White space is seen on the left or right side of the label)

Two printer driver settings can affect this issue:

Left Margin Offset. This adjustment is found in the Status Monitor. If you see white space on the right side of the label and overlap on the opposite side, increase the number. If you see white space on the left side of the label and overlap on the opposite side, decrease the number (Negative numbers are allowed).
Note: Usually a space on the right side indicates a margin around the label that is not being accounted for. The printer is factory calibrated for a 2mm margin. A larger margin around the label will cause a right-side space.

Page Size. Often the page size is not large enough for the label. If this is the case you may see white space on the right side of the label and no image overlap on the opposite side. This indicates that the page size needs to be increased. Increase the page size through the printer preferences enough to cover the label.

6B. Solving Cut Alignment Offset Problems

Cut alignment is calibrated at the factory. However, it is possible that you may need to adjust the cut line position for certain prints/cuts.

Adjust Cutter Offsets by opening UNINET IColor Print Hub. Go to the Printer Settings tab. Click on the Advanced Settings button. Adjust cutter offsets according to the diagram below. To move the cut to the right increase the Horizontal Offset. To move the cut to the left decrease the Horizontal Offset. To move the cut up increase the Vertical Offset. To move the cut down decrease the horizontal offset. Remember the top of your document prints first so it prints upside down if you are standing in front of the printer.
6C. Maintenance

Replacing the Cutter Wear Strip

The wear strip is the surface directly underneath the cutting blade in the cutter mechanism. Over time this strip will wear down due to cutter knife pressure. It can also be damaged if the knife cuts through the liner and contacts the wear strip.

To replace the wear strip, remove any media from the cutter mechanism. Power off the Printer. Push the knife carrier gently to the left. Grab one end of the wear strip and pull it off the cutter. If necessary, use a utility knife to get under the strip to start it. The wear strip is held in place with adhesive so there may be adhesive residue. Clean off the adhesive with isopropyl alcohol.

Remove the liner from the new wear strip. Press the strip into place. Make sure it is fully seated in the recessed pocket.

Replacement Wear Strip

Label Cut Dust

Label cut dust can accumulate at any place along the cut path.

Paper media creates more dust than synthetic material. Dust build-up does not cause any specific immediate problems but it can eventually cause problems with the moving parts and electronics in the cutter.

Periodically vacuum the cutter area and rollers.
Cleaning the Printer

The case of the printer can be cleaned with an ammonia-based window cleaner and a lint-free cloth. Over time, ink overspray may gather at the base of the printer. The printer is designed using a vacuum system to gather most of this ink on a series of saturation pads. Eventually, these pads may need to be replaced. Contact tech support to determine if pad replacement is necessary.

Ink Accumulation - Chutes

Ink build-up can occur in the spit chutes that lead to the ink saturation pads. Pigment Ink tends to build up faster than Dye Ink. Make sure there is a clear path for the ink to reach the pads below. Partially dried ink can accumulate around the sides of the chute. Use a ridged flat edge such as a pairing knife to scrape away the ink.

Ink Accumulation – Wipers (A software and firmware update may be required. Run the update first)

If you notice that your print quality is poor at the beginning of a print but gets better as it continues to print, your ink wipers may have accumulated a combination of cut dust and ink. Check the wipers and clean them with rubbing alcohol and a cotton tip cleaner. Wipers are located on the right side of the printer but are normally hidden from view under the cartridge. You will need to put the printer in the wiper maintenance mode.

1. Open the top cover.
2. Press and hold the pause button for 3 seconds until you see the print carriage move.
3. You will now have access to clean the wiper.
4. When complete close the cover.
6D. Poor Print Quality – Cleaning the Cartridge

It may be necessary to clean the ink cartridge nozzles if you notice reduced print quality, or if you suspect a cartridge nozzle has become slightly dried out or clogged. If the cartridge has been left out of the printer for more than 30 minutes, the ink in the print head nozzles may have dried.

If you are having print quality problems, follow the steps below:

1. Before moving on to the next step, ensure that the ink level of the color cartridge is more than 10%. If the ink level is lower than 10%, replace the cartridge.

2. Try cleaning the cartridge using the clean function in UNINET IColor PrintHub.

3. Determine if printing is now acceptable by printing your image. If the sample has missing colors or voids within a color strip, remove the cartridge from the printer and proceed to step 4.
4. Prepare items needed for the procedure

Two Paper Towels
folded four times each

A Glass of Water

5. Soak the paper towels in water for 5 seconds.
6. Place one paper towel on cartridge nozzles. Gently press the paper towel with your finger. Leave the paper towel on the nozzles for 30-40 seconds.

7. Wipe nozzles.

a. Place the second paper towel on a flat/hard surface.
b. Press the nozzles into the paper towel.
c. Firmly tap the top of the cartridge three times to force the ink out.
d. Wipe/ Drag the cartridge in the direction indicated.
e. Repeat until all colors are seen on the paper towel. After wiping the nozzles, the paper towel should show all three colors. If all three colors are present, proceed to step 8. If the paper towel doesn’t show all three colors, then repeat step 7. If the paper towel still doesn’t show all three colors repeating step 7, then replace the cartridge.
8. Dry the cartridge.

9. Verify cartridge is now functioning properly by printing your label.

6E. Technical Support

If you have difficulties operating your Printer, contact technical support using one of the methods listed below.

<table>
<thead>
<tr>
<th>Source</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNINET IColor Knowledge Base</td>
<td><a href="http://www.icolorprint.com/support">www.icolorprint.com/support</a></td>
</tr>
<tr>
<td>Email Support</td>
<td><a href="mailto:sales@icolorprint.com">sales@icolorprint.com</a></td>
</tr>
<tr>
<td>Phone Support</td>
<td>+1 631.590.1040 (Mon - Fri 9 a.m. – 5:30 p.m. EST)</td>
</tr>
</tbody>
</table>
## Section 7: Technical Specifications

| **PRINT SPEED** | Pre-die cut media: Up to 4.5” per second  
Digital die-cut speeds are dependent upon the image being cut |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PRINT RESOLUTION</strong></td>
<td>Up to 4800 x 1200 dpi</td>
</tr>
<tr>
<td><strong>PRINT TECHNOLOGY</strong></td>
<td>Thermal Inkjet</td>
</tr>
<tr>
<td><strong>INK TYPES</strong></td>
<td>Dye-based CMY, Pigment CMY</td>
</tr>
<tr>
<td><strong>LABEL TYPES</strong></td>
<td>Pre-die cut, continuous and black marks</td>
</tr>
<tr>
<td><strong>STANDARD CONNECTIVITY</strong></td>
<td>USB 2.0 (USB 3.0 compatible)</td>
</tr>
</tbody>
</table>
| **PRINT WIDTH**  
(DIGITAL DIE-CUTTING) | 0.5” (13mm) - 4.25” (108mm) Digital Die Cut media width is fixed at 4.25” However, smaller size labels can be cut from the 4.25” media. See Note on Page 17. |
| **PRINT WIDTH**  
(PRE-DIE CUT) | 0.5” (13mm) - 5” (127mm) |
| **MEDIA WIDTH** | Pre die-cut: 2.125” (54mm) to 5.25” (133mm)  
Digital Die-cut: 4.75” (121mm) (4.25” Printable) |
| **MAXIMUM PRINT LENGTH** | 12” (305mm) |
| **OPERATING SYSTEM** | Windows 7, 8, or 10. |
| **DIMENSIONS** | 13.6 W x 17” D x 9.5” H (345mm W x 432mm D x 242mm H) |
| **WEIGHT** | 12.5 lbs (5.7kg) |
| **POWER** | Input: 100 – 240 VAC, 50/60 Hz, 60 watts, Output: 12 volt 5 amp |
| **WARRANTY** | One-year parts and labor; lifetime phone, chat, and email support |
| **OPERATING TEMPERATURE** | 50 to 95° F (10 to 35° C) |
| **RECOMMENDED**  
OPERATING TEMPERATURE | 61 to 87° F (16 to 32° C) |
| **STORAGE TEMPERATURE** | -4 to 140° F (-20 to 60° C) |
| **OPERATING HUMIDITY** | 10 to 60% RH (non-condensing) |
| **STORAGE HUMIDITY** | 10 to 80% RH (non-condensing) |
| **CERTIFICATIONS** | UL, UL-C, CE, FCC Class A |
| **REPLACEMENT INK CARTRIDGES** | UNINET IColor Pigment  
UNINET IColor Dye |
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, according to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used per the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.